
Puppy Linux Setup Guide

How to make Puppy Linux a full workstation OS

Before you actually start
Backup your data
Don’t use the built in burn software from MS it does not make real ISO compatible CDs. 
Use a 3rd party software which is approved to make a good ISO Disc. There are also 
freeware burner software packages known to be OK. Or you can use a FAT formatted USB 
Stick. Or both. Just to get sure.

1. Get the right Puppy
There are different versions of Puppy Linux

Precise Puppy
Slacko
Wary
Racy

2. Setup
Boot from CD
Format Disc

GParted
Install

Full Install
Configure GRUB

Default Values

3.Boot from Disc
First steps

Setup Your Locale
Download your langpack pet from „Common“ Repo
Setup CUPS

PDF Printer Setup
Ink Jet Printer Setup

gutenprint
CUPS plus ppd

Check Network Settings
Switch off Energy Saver for screen if necessary
Give „Lock Screen“ a Password

4. Additional Software
PPM or download?

Get Microsoft Fonts
cabextract
msttcore fonts

Seamonkey as a pet to make upgrades possible
LibreOffice 3.5.1
Softmaker Office 2008
Adobe Reader 9.3.3
Foxit Reader 1.1
Java JRE 1.6
Avast Linux Home Edition 1.3.0
Games - Ace of Penguin
Abiword uninstall and install as pet (optional)

5 Further Steps
Set Default Applications
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Change Printer Error Policies to „abort Job“
Change JWM Settings to double click
Change JWM Settings Image Preview „on“
Load Desktop Images
Lock Desktop Icons to Desktop
Set GTK Themes
Set  Icon Theme
Drag Desktop Folder to Desktop
Create Private Folder
Drag Private Folder to Desktop

6 Some Linux Commands
df
df -h
xwininfo

7 Interesting Things
Why does the hard disk light flash every 4 seconds?
nd disk with extra files
How to import data

1. Get the right Puppy
There are different versions of Puppy Linux

Precise 
Precise is Ubuntu Based and has long term support. Works fine on P IV Machines with 512 
MB Memory installed. Supports RAM >4GB, Multi Core Processor Machines, Physical 
Address Extension required. If Physical Address Extension is not present in your 
Processor, the machine won‘t start. Get the Version without PAE. PAE is present on most 
Intel Processors (P I and higher, but Pentium M often have no PAE). AMD Processors with 
64bit Technology have PAE, the others don‘t. A Pentium /// Machine is suitable for basic 
needs like mail, basic web, word processing. Setting up a SWAP Partition is recommended 
if RAM is 256 or 512 MB. I use a P IV Machine with 1 GB RAM and the SWAP is almost 
never used, but i keep it just in case it is needed.

Slacko
Based on Slackware 14. It features 4g and PAE linux kernels. Supports many wired and 
wireless network connections, dialup with external modems, cell phones and 3G 
modems.

Wary
Based on T2 Linux. Old kernel, configured for uniprocessor i486 CPU, modem drivers, 
analog dialup and old hardware. Good for old CRT Monitors without EDID feedback, can 
be set up manually. No SMP no PAE, runs on almost anything.

Racy
Based on T2 Linux. Racy is configured without PAE support (so only accesses first 4GB of 
RAM), and for a i686 CPU. It has SMP (multi-core) support. Newer Xorg Video Drivers.

I suggest getting all four versions and check out by yourself which version suits your 
needs best. 
These Information refers to version 5.4. For newer versions, check version info.

2. Setup
Boot from CD
Set your machine to boot from CD. Consult your BIOS Manual which key to press to get 
into the BIOS. Mostly it is the DEL-Key. IBM often uses F1-Key. HP F10-Key. Old Siemens 
uses INS-Key. New Siemens-Fujitsu DEL-Key. But as I said, consult your system manual 
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first or ask a friend or technician or a service line if you have trouble getting into the 
BIOS. Or check out via the internet. Get the manual read the manual. Set your machine 
to boot from CD. Best Boot Order you can set is. 1. CD 2. Hard Drive. 

Boot from CD. This might take 1 or 2 Minutes. 

Format Disc
Now we partition and format the disk using GParted.
Click on Menu. Go to menu entry system and select GParted.
If you have a completely empty disk create a DOS Type MBR first. Then create a ext2 
partition. Then create a SWAP partition if needed/wanted. 

I recommend setting up a SWAP partition. If RAM is less or equal 512 MB create a SWAP 
with double size of your RAM size. If RAM is 1 or 2 GB set SWAP Size to 1GB Size. Above 2 
GB RAM no SWAP is needed. If desired take 1 GB just for compatibility reasons. Maybe a 
program will ask for a SWAP partition.

I prefer using ext2. It is mature, fast and reliable enough. ext3 is like ext2 but adds a 
journaling function. If your system crashes or something like that, reboot goes without 
checking the file system since ext3 „knows“ which files were in use at the time of 
crash/reset. But journaling takes time and space. That‘s the reason why ext2 is quicker 
and more compact. I recommend it because I use it and it works fine for me. 

When Partitions are set, use the Apply-button to make your settings work. Then after 
partitioning format the ext2 partition. SWAP needs no formatting.

Quit the Program, reboot, start GParted again an look if all settings are still there. If all is 
shown the way you want OK, That was good job.

Install
Mount the CD, just click on the desktop CD icon. When the icon gets checked with a cross 
in the upper right corner it is mounted successfully.
Now we install the system itself. Launch the Universal Installer from the menu. It will ask 
you a lot of things. Target, source and the type of install. We choose „Full Install“ because 
in that tutorial we are going to set up a full desktop operating system. We intend to use it 
as the primary system on the computer. 
When all the questions are answered, the installer will copy the contents of the CD to 
hard disk. During that time on some puppies there is no window with a progress bar or 
so. Just wait until the installer finishes. It will bring up a pop up window telling you that 
the installation was successful. I never had problems installing, on hard disk so I can‘t tell 
you anything else.
Now don‘t reboot go immediately to the next step to finish your work.

GRUB
To make the installation bootable we install GRUB for DOS. Just launch the program 
answer all the questions and you are done.
For the basic install there is a good manual available here. 
I edited menu.lst to make the computer wait 30 seconds at boot. So you have more time 
to interact if manual interaction is needed. If you have a CRT 10 seconds may be to short 
to actually see the GRUB boot menu. 

3. First Boot
Now the first boot. Reboot your computer. If everything works well the machine will boot 
right to the desktop and launch the first run wizard. Set your keyboard and stuff. Check 
your monitor resolution. Check your network settings.
Set up your locale and download your langpack from the “Common” Repository or use 
the Puppy Package Manager to download and install the pet package. If you use the PPM 
your downloads are stored in /tmp. They will be kept there until the computer is being 
rebooted. After shutdown/reboot the files will be deleted. So go and move them to your 
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“my documents” folder if you want to save them for later use. If you downloaded the pet 
file via browser, just double click and the installation takes you through two dialogues 
and you’re done.

Setup CUPS
PDF Printer Setup
Puppy comes with a PDF printer queue installed. But my experience was that it is not 
configured correctly. So just delete it in the CUPS Window and create a new one.
Go to the menu >> System >> CUPS. The default web browser starts. If a small windows 
pops up asking if you would set up a new printer or not, say no. If you say yes an 
additional help window pops up. That’s the whole difference between yes and no in this 
case.Go to “Printer” select PDF printer tick “administration” select “delete printer”
Now set up a new PDF printer queue using the PPD “generic postscript”. That should 
work. Test it. The test print goes into a folder called “Exports”. (Search with pfind). If the 
job was done successfully check out by looking into the jobs section within the CUPS 
window. 

By the way you should change the error policy from “stop printer” to “abort job”. This 
can be done in the printer section. Otherwise if a printing error occurs or a job is 
canceled, you have to start the printing queue manually.

Ink Jet Printer Setup

Now we set up an ink jet printer. Support for a lot of ink jets has become better over the 
years. In this short tutorial I only cover one printer model. I do not have several printers 
for testing. As a preliminary step you should get a PPD file for your printer. There are 
several PPDs in the Puppy Forum, maybe your manufacturer has one. Just look around in 
the net. I found mine by using a search engine. I typed the name and type of the printer 
and added .pet to the search job. And got a link to the Puppy Forum. If you can’t find a 
PPD for your printer, maybe gutenprint has one already compiled in it’s collection, and 
you don’t have to look around.

Printer setup using gutenprint
Start the CUPS tool from the Menu>>System>>CUPS
Want to add a printer say “Yes”. A help window opens, and the default browser opens. 
Now I don’t want to explain every single step, i’d rather explain the deeper sense beyond 
the simple steps.
The next steps take you through some questions, which port is the printer connected to, 
name and location and so on. When it comes to the point which PPD to use you can 
select from a list of manufacturers. I chose Canon and browsed through the list of 
models. My Pixma iP2700 was listed as Pixus iP2700. If you choose such a built in PPD 
usually there is an addition +gutenprint in that name. Click your appropriate model and 
create the printer. Change the printer policies to suit your needs. Change them after the 
first test print to see if the default values work. A test print can be done from the CUPS 
window. The gutenprint PPDs usually have a lot of features that you can adjust. But 
sometimes the gutenprint driver has it’s own kind of “problems” i’d like to say. In my 
case i can’t print pictures in grayscale. If i try to print a color picture as grayscale the 
printer blinks, but no output. Another issue is speed. The output is absolutely perfect, but 
it is very slow. So that is the first out of my three printer queues.
Hint: If Gutenprint does not list your printer model, browse to check if your model has a 
different name. Like seen above. In Japan Pixus in Europe Pixma. But the same model 
number. Or vice versa. Such things happen. Maybe due to marketing decisions or brand 
name issues. 

CUPS plus ppd
Now we set up a printer for quick an easy use. In color and grayscale, so users can select 
either a gray or a color output queue and the rest is already set in CUPS as default 
values. To make it easy for users. Just print and go.
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Get your PPD if not already done. Use a search engine, or get it from openprinting.org, or 
from your manufacturer’s website or as a pet file from the Puppy Linux Forum. The 
advantage of using a pet file is clear. Easy to install. If you have a bare PPD no problem 
either. Just save it in an extra folder in your home folder. Leave it there. Now create a 
new printer like i mentioned in the previous paragraph. When it comes to the point where 
you have to select the PPD, use the choose button and select your ppd. If you have used 
a pet you’ll find your PPD in the default folder of CUPS. Otherwise browse for the folder 
containing the PPD and select. 
Now we have the CUPS printer. Choose your policies, error handling etc. 

Grayscale: Do the same once again with your patched PPD. 
How to patch the canon PPD to make it work in grayscale.

************** Here follows Copy & Paste from a Gentoo User ******************

Three weeks ago I declared my printer dead. That was a difficult decision but the black 
printing doesn’t work anymore. My options were to buy a new and luxurious HP printer or 
maybe get another cheaper Canon and battle 30 minutes to make it work. My budget 
said me “GET THE CANON” and I got it working in a 64 bits Funtoo ^_^.

So one of the first thing that I forget about Canon printers is how to enable the gray scale 
printing, the economic modes, and the higher resolutions. Canon only gives a .ppd 
(Postscript Printer Driver) file with RGB mode, 600 dpi in resolution and normal printing. 
But if I elect a cheaper printer I want the cheapest cost of property  . So let’s enable it.

Step 0: Uninstall it.

Yes, if you have installed the printer. You need to uninstall it because we need to edit the 
properties in the .ppd file.

Step 1: Find your .ppd file.

With a find or an slocate

 find / -name canon*.ppd

# slocate -e / canon*.ppd

Step 2: Edit the .ppd file

This procedure is generic in most of the Canon printers (I tried with ip1000 and ip1800), 
in the case of the ip1800 you have to open the file with your favorite text editor:

# vi /usr/share/cups/model/canonip1800.ppd

Lets edit it. First of all we need to ADD this lines to enable the grayscale

*OpenUI *CNGrayscale/Grayscale: Boolean
 *DefaultCNGrayscale: False
 *CNGrayscale True/Yes: True
 *CNGrayscale False/No: False
 *CloseUI: *CNGrayscale

And to enable the economic and higher quality printings ADD:

*OpenUI *CNQuality/Quality: PickOne
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 *DefaultCNQuality: 3
 *CNQuality 2/High: “2″
 *CNQuality 3/Normal: “3″
 *CNQuality 4/Standard: “4″
 *CNQuality 5/Economy: “5″
 *CloseUI: *CNQuality

To enable more resolutions we need to EDIT this section:

*OpenUI *Resolution/Output Resolution: PickOne
 *DefaultResolution: 600
 *Resolution 600/600 dpi: “<>setpagedevice”
 *CloseUI: *Resolution

replacing it with:

*OpenUI *Resolution/Output Resolution: PickOne
 *DefaultResolution: 600
 *Resolution 300/300 dpi: “<</HWResolution[300 300]>>setpagedevice”
 *Resolution 600/600 dpi: “<</HWResolution[600 600]>>setpagedevice”
 *Resolution 1200/1200 dpi: “<</HWResolution[1200 1200]>>setpagedevice”
 *Resolution 2400/1200 dpi: “<</HWResolution[2400 1200]>>setpagedevice”
 *Resolution 4800/1200 dpi: “<</HWResolution[4800 1200]>>setpagedevice”
 *CloseUI: *Resolution

That’s all, now we have enabled the economic modes
*********************** end of copy & paste ***************
Thanks to gentoo user. 
This is not for newbies, but with a little experience or help of a friend it is too difficult. I 
only added the grayscale section, and changed the default to “True” meaning that 
grayscale is checked by default.
Check the network settings.
One thing first. My network connection worked out of the box. I have a netgear router 
with DHCP enabled. No problems. It was detected and so I never had to make any change 
to my configuration. 
For all the other dudes who do not use DHCP via a wired LAN Connection, here are a few 
tips. 
Click on the tool icon on the desktop to open Puppy Setup. Click on the button 
“Conncect to Internet or internal network”. Click Button “LAN or WLAN”.

Most People should click “Simple Network Setup” it requires a DHCP Server.
Most internet router devices contain a DHCP Server. Consult your router 
documentation to set it up. 

All other people have to use Network Wizard. 
You can either choose a DHCP Server or you can set up a static IP address.
If you use DHCP keep in mind that every machine, be it computer or network
printer, has to have a unique machine name. This can be set here too.
No words on WLAN, since i do not use it. 

Hot to set up static IP addresses
A regular IP address contains at least three things.
IP address in a typical Small Office Home Office environment is 192.168.xxx.xxx
The corresponding Subnet Number to the above address range is 255.255.255.0
Gateway is usually the address of your routing device.

If you want to use the internet it may be necessary to obtain the addresses of at least 
one, better two DNS servers. Normally these addresses are obtained automatically from 
your ISP if your router runs DHCP. So even your printers/workstations run on static IP 
leave DHCP on. Create an address space for your static IP addresses It is better to set a 

6



server to a static address In a small network you will mostly have to mix static and 
dynamic address allocation. Don’t forget: Use every computer name and IP address only 
once. Make a list of your uses addresses/names. Networking is documentation. 

Switch off Energy Saver for screen if necessary
In standard configuration the screen goes into sleep mode after 10 minutes. This can be 
impractical, especially in a classic desktop configuration. 

So I switched it off.
Go to Menu >> Desktop >>PupX Settings

Here you can set the screensaver. I only managed to set the screensaver on or off. But i 
could not set a different time to make the screen sleep. You I just switched it off. Maybe 
the option works better in a newer version. Keep in mind that flatscreen monitors have a 
kind of neon bulb to provide backlight. Lifetime can be shortened when the backlight is 
switched on and off all the time. It might be better not using the screensaver option in 
this case. CRT and LED backlit screens are not affected by this.

Give „Lock Screen“ a Password
Click the lock icon on the desktop. If the program runs for the first time it will ask for a 
password. Enter a password. Confirm your password. Don’t forget it. Even if you never 
ever use the lock screen feature, set a password, just to avoid that someone sets a 
password by accident. Provides a nice lava lamp.
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Additional Software

PPM or download?
Like a lot of other linux distributions, Puppy Linux has it’s own package manager. To use 
Puppy Package Manager start.

Desktop >> Install icon >> Puppy Package Manager

Once started, you should see the main Puppy Package Manager window open up:

Installing an Application using the Puppy Package Manager

Once the Puppy Package Manager has been invoked, use the radio buttons down the side 
of the dialogue to select the category in which your chosen application fits; this will 
display a list of the available applications in the main pane of the window. Scroll down 
and click on the desired application (-or use the "Search" field if you know the application 
name):

Double-click the application to start the install: Puppy will first check that you have the 
right permissions, all required libraries are installed and there is enough space to 
continue with the install. If you want to continue with the installation - click on the 
"Install.." button in the confirmation dialogue that appears:

Puppy will then ask you which mirror site you wish to download from: choose the one 
nearest to your location, then click on the "Download Packages" button to begin:

A window will open up, showing you a progress bar representing the status of the 
package download. Once completed, this window will close and you should see the 
following dialogue box (-assuming all went well):

Click "OK" to close the dialogue box. A background window may open up stating the 
following:

This informs you that Puppy is finalizing - and doing various integrity checks on - the 
install. Assuming all is good, you'll get yet another dialogue box, this time stating:

Once again, just click "OK" to close the dialogue box. If you want to verify the application 
has installed correctly, simply look for it under the Puppy main menu:

Installing a PET file without the Puppy Package Manager (PPM)
Another way to install a software package is to download the pet file with seamonkey. 
Download the desired package. Download additional files when needed. I.e. if you need 
language support other than English get the NLS files that correspond to your 
application’s name. DOC is the suffix for Documentation. DEV are files needed by 
developers.
I usually load DOC and NLS to have a full install. 

Next step: Click your downloaded PET. A window opens telling you that you are going to 
install a software package. Confirm by clicking “Yes”. After a short while the installer 
window is telling that a installation took place and was finished. Confirm. A background 
window opens telling you that the application is being put into the menus and a 
dependency check is made. That’s it. Keep the files for later use or an another computer. 

This method has advantages over using PPM. 
Downloaded software can be used more than once, you can distribute software if you 
have more than one PC. You can build up a software collection. Nice for internet 
independent installations.
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How to remove an application.
Start PPM. Check the window “Installed Packages” click your software which you want to 
delete. Say OK to delete. Wait until the operation took place. Quit PPM.
Get Microsoft Fonts

cabextract
msttcore fonts

Now we are going to install the microsoft core fonts. It is suitable for all people who share 
office documents with Microsoft Users, or people who use the MS Core font collection as a 
common font base across platforms. 
Get the core fonts here: http://web.nickshanks.com/fonts/microsoft-core-web-fonts
They are packed as *.exe files and have to be extracted first by using the command line 
tool cabextract. Don’t be afraid, it is not too complicated. But it is a bit of time consuming 
work. The benefit is that you can read all documents from other people using the 
mainstream font families without having strange looking line- and page breaks.

Get cabextract here: http://www.smokey01.com/coolpup/cabextract-1.4-d-20110523.pet

Download it, double click to install or use PPM and keep it for later use.

Then do as follows.

Usage: cabextract [options] [-d dir] <cabinet file(s)>

This will extract all files from a cabinet or executable cabinet.
For multi-part cabinets, only specify the first file in the set.

Options:
-v --version print version / list cabinet
-h --help show this help page
-l --list list contents of cabinet
-t --test test cabinet integrity
-q --quiet only print errors and warnings
-L --lowercase make filenames lowercase
-f --fix fix (some) corrupted cabinets
-p --pipe pipe extracted files to stdout
-s --single restrict search to cabs on the command line
-F --filter extract only files that match the given pattern
-d --directory extract all files to the given directory

cabextract 1.4 (C) 2000-2011 Stuart Caie <kyzer@4u.net>
This is free software with ABSOLUTELY NO WARRANTY.

After unpacking the cabinets, you have to move the fonts into the fonts folder from 
puppy which is:

/usr/share/fonts/default/TTF

After restarting X-Server from the Menu the fonts are ready to run and you should see 
them in the fonts pull-down menus of your word processing software for example.
(Text taken from Puppy Linux Wiki)
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Additional Software:
Now we are customizing our puppy to make a fully functional office system.

That’s what we are going to install. 

Seamonkey as a pet, to make upgrades possible using the Seamonkey update channel.

download at: http://www.silverdollarsolutions.com/PuppyLinux/asterisk/

Next uninstall the built-in seamonkey using the built-in software removal tool.
Load the seamonkey pet package. This way you removed a preconfigured package and 
you get standard installation of seamonkey which is easier to maintain.

LibreOffice 3.5.1
Get pets from here: Check Puppy Linux Wiki Site. See --> More Software.
Install by double clicking the pet. Don’t forget to install your additional language pack for 
LibreOffice. I decided to take version 3.5.1 because it is mature. One of the key features 
of LibreOffice is that it is available for Windows, Mac and Linux Systems. I like software 
which does not tie people to a specific platform.

Softmaker Office 2008 
Download from the official repositories
Download Softmaker Office 2008. It consists of 3 packages. In the repository there are 
three different versions. Be cautious, load the corresponding packages. They can be 
distincted through the name extensions. I took the batch of packages with the -2-x86 
extension. Get a serial number from the softmaker website. It is for free. Keep it for 
installation. (Batch of pets consists of application, DOC (documentation), NLS (native 
language support)

Adobe Reader 9.3.3 
Download pet from www.puppylinuxfaq.org
This pet was made for Lucid Puppy, but i use it in Precise 5.4.3. It works OK but printing is 
flaky. When printing, don’t browse in the document. Jump to page one. Then go print. Use 
the options for selecting which pages to print from there. I do not recommend this pet for 
everybody. Since Puppy Linux has ePDF as default reader which is very good. But Adobe 
Reader has a few functions which some people need. Like full text search within a batch 
of documents. Or to give people the same basic tools and applications in a mixed 
environment. Considerations if or if not to use Adobe Reader are more subject to a 
nontechnical approach sometimes. Difficult? Think!

Foxit Reader 1.1
Download it from the Lucid Puppy repository
Fast and stable,english only. 

Java JRE 1.6
Download at: http://www.silverdollarsolutions.com/PuppyLinux/asterisk/
Install. Disable the browser extension in seamonkey. I use it for LibreOffice 3.5.1 
database only. Newer Java stuff is available there too. But as I mentioned before i 
recommend things only that work. Which does not mean that other combinations don’t 
work.

Avast Linux Home Edition 1.3.0
Install via PPM or official repo. 
Good tool to check your data files for computer viruses. Helps to prevent unwanted 
distribution of ugly stuff. You will have to register this program at Avast in order to get an 
antivirus database file. Free of charge. For information check the Avast website.

Games - Ace of Penguin
Go to this website: http://www.smokey01.com/
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Click the green button on top. Switch to the “Fun” category.
Download the pet. You get a few nice card games. Including a real good clone of the 
windows solitaire. A lot of people like it. 

Abiword 2.8.6 uninstall and install as pet (optional) --> Get it from official repo.
This is not necessary, but i did it just to get a working spell checker in german. Still no 
success. But this way i was able to gain control which parts of Abiword are installed. Still 
trying to make international spell check possible. Addendum: Had success by using the 
pet files from Wary. Install the Abiword PET and the DOC and NLS PET with the ending 
w52 in the filename. Then spell check works.

5 Further Steps
Set Default Applications
Go to Menu >> Configuration >> Default Applications >> Select your default apps

Change Printer Error Policies to „abort Job“
Don’t forget to set your printer policies while setting up your printer. Otherwise, if you 
cancel a print job you have to start the print queue manually. Not convenient, and many 
users are not able to set a printer queue back into operational state. 

Change Rox Filer Settings to double click
Change Rox Filer Settings Image Preview „on“
Open any folder. Right-click in the window. Make sure to click in the white background of 
the window. A menu pops up. >> Options >> Make your settings. I recommend the two 
settings above to make system easier to use. It is more PC/Mac like. 

Load Desktop Images
Lock Desktop Icons to Desktop
Set GTK Themes
Set  Icon Theme
Drag Desktop Folder to Desktop
Create Private Folder >> Use the open close Dialog. Folder will be created in 
/root/Desktop
Drag Private Folder to Desktop

Use Pup-Advert Blocker. It uses a modified hosts-file to block advertisements. No different 
adblockers anymore. And it works for all browsers, even for browsers that do not have an 
adblocker available.

AbBlock Plus for Seamonkey is great too, but i can cause a delay upon loading the 
application on a slower machine. On my machine (Celeron 2.8 Ghz) 5 seconds loading 
time saved using the Puppy Advert Blocker. 

How set double click speed for the mouse.
Puppy has no switch to set double mouse click speed. I found a solution in the puppy 
forum. Here it is.
There are several more post in the forums about double clicking and changing the double 
click speed. Some have the answers, but most don't offer many details. For the record, 
single click/double click is controlled by Rox and the speed is controlled by GTK. So, if you 
want to change to double click here are the details: 

11



To set double-click: 
-open Rox filer 
-right click in an empty space in the filer window 
-click Options 
-click Filer windows 
-uncheck Single-click Navigation 
-click Pinboard 
-uncheck Single-click to open 
-click OK 

To adjust double-click speed: 
-open the Geany editor 
-click File/Open 
-click root in the Places window 
-click Show hidden files in the lower left of the window (will be under More Options in 
newer versions) 
-scroll down and click the file: .gtkrc-2.0 in the Name window 
-click the Open button 

Add this line to the bottom of the file: gtk-double-click-time = 500 
-click File/Save 
-reboot for changes to take effect 

You can adjust the 500 number up or down to change the speed, reboot between 
changes 

Credit for these solutions belongs to others who have posted, I have just filled in details 
of how to click through it.

A word on PDF production:
There are three basic ways to produce PDF
1st: Use the print to file option: No good way in my opinion, since some fonts do not get 
included properly. 
2nd: Use the CUPS-PDF printer: Good option if you installed it the way i mentioned above.
Fonts are included, but text search in Adobe Reader does not work. Works from all 
applications who support printing.
3rd: Use the PDF export from Libre Office: Best option, fonts are included and text search 
in Adobe Reader works. If you plan to publish larger PDF documents, you should consider 
the Libre Office way.

On Screen Keyboard
It may be necessary to have a on screen keyboard. Here is how it works.
Install these three packages from the puppy forum. Then invoke xvkbd on the terminal 
and you get an on screen keyboard. I used the Lucid Version for Puppy Precise 5.4.3 and 
it works.
xvkbd is a virtual (graphical) keyboard program for X Window System which provides 
facility to enter characters onto other clients (softwares) by clicking on a keyboard 
displayed on the screen. This may be used for systems without a hardware keyboard 
such as kiosk terminals or handheld devices. This program also has facility to send 
characters specified as the command line option to another client. 
 
Installation
Download and install the appropriate package:-
 
xvkbd 3.2 for Puppy3 and Puppy5.3 Slacko download page
xvkbd for Puppy3 and Puppy5.3 Slacko discussion
 
xvkbd 3.1 for Puppy5.2x Lucid download and discussion
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http://puppylinux.org/wikka/xvkbd#hn_Installation
http://murga-linux.com/puppy/viewtopic.php?t=37194
http://murga-linux.com/puppy/viewtopic.php?t=67133
http://dokupuppylinux.tk/programs:virtual_keyboard
http://puppylinux.org/wikka/PETs


LibreOffice A4 default
Start LO, then pick Writer from the LO start screen.

Go to Format > Page. Set your size to A4 and portrait.

After that go to File > Templates > Save

Give it a name.

Go to File > Templates > Organize

Double click on “My Templates” and right click on your template. Choose “Set as default 
template”. That’s it. Do so with the other parts of LibreOffice, since every part of 
LibreOffice has its own templates. 
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